TABLE OF CONTENTS

Preface

Chapter 1:  Hardware Installation and Setup

Chapter 2:  Software Setup and Configuration

Chapter 3:  Operating Instructions

Chapter 4:  Image Express™
for Remote Retrieval of DICOM Studies

Chapter 5:  Image Central™
Web Service and the Browser Based Viewer

Appendix
Hardware Specifications
Error Conditions and Actions
HIPAA – A White Paper
Preface

- **THANK YOU** – For purchasing the Radlink LaserPro16 – Laser Film Digitizer. This manual will assist you in learning all the functions of your Laser Digitizer, from installation through operation. Please read each section carefully.

- **SAFETY** - Read and follow all warning and safety instructions in this User’s Manual and marked on the product. Not following the instructions may be hazardous or illegal.

- **INSTALLATION** – Follow the Installation Instructions in this manual carefully. Use only the supplied accessories. If parts are missing, contact Radlink before proceeding.

- **INTERFERENCE** – This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a commercial installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause interference to radio communications.

  Properly shielded and grounded cables and connectors must be used to meet FCC emission limits. Proper cables are available only from Radlink or its authorized dealers.

- **QUALIFIED SERVICE** – All service must be performed by the factory. There are no user replaceable parts inside the scanner. DO NOT remove the covers as internal parts may be damaged, the warranty will be voided and it may be hazardous to your health. The only user replaceable part is the power supply and then, only after the factory has verified that the current supply is defective.
Introduction

The *Radlink* 16 Laser Scanner is a radiological device, which scans x-rays and transmits the image to a host computer for review and archiving or forwarding to other facilities for further evaluation and archiving. The scanner handles film from 2 inches x 2 inches (minimum) to 14 inches x 15 feet (maximum – a reasonable length is 17 inches). The scanner’s unique design makes it virtually maintenance free, as there are no mirrors or galvanometers, which are subject to frequent adjustment. Additionally, the scanning mechanism is shock mounted to allow for more reliable operation. The scanner is in continuous “calibration mode” except when scanning, assuring reliable imaging.

Multiple files are supported including TIFF, JPEG, PNG, BMP, Dicom and Raw formatted images for both reading and writing. Conversion from one file type to another is automatic.

Multiple images may be sent simultaneously to the PACS hosts and the Dicom Spooler handles multiple destinations and a Dicom broadcast capability. The system also supports the opening of Dicom 3.0 files.

The scanner has relatively few controls and connections making the installation process a quick and efficient procedure. Operating over either the USB or Ethernet port requires the easy attachment of a supplied cable. The software completes the remainder of the installation.

An external power supply accepts input voltage from 85 VAC to 264 VAC, 47 Hz to 440Hz at 3.20 A (rms) for 115 VAC/0.90 A (rms) for 230 VAC Input current, allowing the scanner to be installed anywhere in the world.

It is recommended that the entire User’s Manual be read before proceeding with the installation.
Chapter 1

Hardware Installation and Setup
Chapter 1: Hardware Installation and Setup

Unpacking the Scanner

Before assembling the scanner, take inventory of the contents of the shipping carton to verify that all parts are included. If any parts are missing, circle the item on this page and return a copy of the page to Radlink immediately and the parts will be replaced.

Mail, fax or phone missing parts request to:

Radlink Inc.
22750 Hawthorne Blvd.
Torrance, CA  90505-3664
Attn: Customer Service

310-373-9763 (fax)
310-373-5673 (phn)

Contents:

Table 1 – Scanner Hardware

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LaserPro16 Scanner</td>
<td>02-00-001</td>
</tr>
<tr>
<td>1</td>
<td>Tray – Film Input</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Tray – Film Output</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Tray – Film Holder</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>External Power Supply</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Cable – Power Cord 120 VAC 10A</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Cable – USB Signal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Cable – Ethernet</td>
<td></td>
</tr>
</tbody>
</table>

Table 2 – Scanner Software

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CD – LaserPro16 16 Application &amp; Drivers</td>
<td></td>
</tr>
</tbody>
</table>

Table 3 – Scanner Miscellaneous

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Manual – User’s</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Warranty Card</td>
<td></td>
</tr>
</tbody>
</table>
**Host Computer System Requirements**

The following lists the minimum requirements to operate the *Radlink LaserPro16* and it’s associated software:

Table 4 – Host Computer System Requirements

<table>
<thead>
<tr>
<th>Host Computer</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium</td>
</tr>
<tr>
<td>Speed</td>
<td>2GHZ or faster</td>
</tr>
<tr>
<td>Memory</td>
<td>512mb RAM</td>
</tr>
<tr>
<td>Storage</td>
<td>30 Gb hard drive</td>
</tr>
<tr>
<td>Input/Output ports</td>
<td>USB serial</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Video card</td>
<td>2 Mb, 1024 x 768 resolution</td>
</tr>
<tr>
<td>Monitor</td>
<td>14 inch 1024 x 768 display</td>
</tr>
<tr>
<td>Communications</td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>10/100 Base-T Ethernet</td>
</tr>
<tr>
<td>Modem</td>
<td>56K Modem</td>
</tr>
</tbody>
</table>

**Host Software Requirements**

The following lists the minimum requirements to operate the *Radlink LaserPro16*:

Table 5 – Host Software Requirements

<table>
<thead>
<tr>
<th>Operating System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>2000 or XP + latest service packs</td>
</tr>
<tr>
<td></td>
<td>XP PRO is the recommended OS</td>
</tr>
</tbody>
</table>

**Installation**

It is important that the enclosed *Warranty Card* be completed and submitted before continuing with the installation to protect for scanner repair and to validate the warranty.
Assuming the computer is set up, the hardware is unpacked and all parts are accounted for, the hardware will be assembled first.

**Hardware Assembly**

**Scanner**

1. Place the LaserPro16 on a solid surface.
2. Attach the three Film Trays to the scanner as shown in Figure 1.
3. With the scanner backside facing you, place the Power Supply on the table and plug the output cable connector into the Power Connector (8 pin DIN) on the backside of the scanner (see Figure 2 and 3).
4. Attach the AC power cord female connector to the Power Input connector of the Power Supply (see Figure 2).
5. Make sure the Power ON/OFF switch (see Figure 3) on the scanner is in the OFF position.
6. Plug the male connector into a properly grounded 15 Amp A/C outlet. It is desirable to have the computer and scanner on an isolated circuit to avoid conducted noise from other devices affecting the quality of operation.
7. Plug one end of the USB cable into the scanner USB port (see Figure 3).
8. Turn the Power ON/OFF switch on the scanner to ON.

This completes the Hardware assembly.
Figure 1-1 – LaserPro16 16 Scanner

Figure 1-2 – Power Supply
Radlink Software Installation

All of the required software is contained on the enclosed CD. This includes the driver, installation and startup program, application and toolkit.

Radlink Installation Procedures

The installation procedures are identical for all supported Microsoft Operating Systems. Windows 2000, 2003, and XP are the supported operating systems.

Radlink First Time Install Procedures

1. The latest service pack might need to be installed. If they do, the next step in the installation will request the service pack be installed. The service packs can be obtained by downloading Microsoft Windows Updates.
2. Double click the “Double Click to Install Radlink” icon. This installs the Radlink application. (Simply inserting the Radlink CD will cause the setup program to be automatically run on most machines).
3. To install the USB driver, plug the scanner into the computer. Windows will prompt you for the location of the driver. Navigate to the Scanner USB Driver folder and use the driver in that folder. DO NOT use the Microsoft default driver (USB in bulk transfer mode). If you inadvertently do so,
open the control panel, then open system, and then uninstall the incorrect bulk transfer mode driver.

4. If you are sending images to Radlink, be sure to enter the correct client ID and Host ID. Your client ID for the Radlink Server is generated by the Radlink server administrator. He can be contacted at 503 697 9218. If you are sending images to other PACS servers, contact their administrators for proper settings.

5. Go to www.eradlink.com and select Software Updates. You should download the entire release folder to your desktop then double click “Double_Click_to_Install_Radlink” program in the downloaded folder. This will start the installation process. There are typically new updates monthly introducing new features. A brief description of the updates is in the file, readme.txt.

6. Ensure that the folder “c:\Documents and Settings\All Users\Documents” has the proper permissions settings. The settings should be for the user group “Everyone” to have full control. If this action is not taken, The Radlink application will not have permissions to write to the eRadlink directory contained therein. If the Radlink does not have permissions, various errors will occur both during operation, as well as during Key Activation.

Radlink Incremental Install Procedures
If you have previously installed a Radlink release, the following are the installation procedures for Radlink Release 4.3:

1. If running Windows XP, install XPSP2 if it is not already installed.
2. Double click the “Double Click to Install Radlink”Icon on the install CD. This installs the Radlink application. (Simply inserting the Radlink CD will cause the setup program to be automatically run on most machines).
3. The Radlink Database will need to be synchronized to your existing Image Archive. Open the Image Acquire Screen and Click “File→Database Maintenance” menu item then click the “Sync. Database” button.
4. Periodically check www.eradlink.com for software updates. Select Software Updates. Read the release notes for the latest release. If a newer version interests you, you should download the entire release folder to your desktop then double click “Double_Click_to_Install_Radlink” program in the downloaded folder. This will start the installation process for the updated release. There are typically new updates monthly introducing new features.

This completes the Software installation procedure
Chapter 2:

Software Setup and Configuration
Chapter 2: Software Setup and Configuration

Change Scan Settings and Destinations

To change scan settings, Select Settings on the top menu bar, then select Scanner. The ScannerSettings screen (Figure 2-1) will be displayed.

![Scanner Settings Screen](image)

**Figure 2-1 – The Scanner Settings Screen**

**Scanner Settings**

**Resolution** – Number of pixels representing a horizontal line
Options are: 1024, 2048 or 3072

**Depth** – Indicates the number of gray scale bits
Options are 8, 12, 14, or 15

**Max Rows** – The maximum length of the scan. As the pixel density is symmetrical, 2048 would be 14 inches for a Resolution of 2048.

**Serial #** – Serial number of the scanner.

**Auto Segmentation** – The images will now be automatically segmented after the scan when this feature is enabled

**Sleep Timer** – Number of minutes before the scanner is placed in
“sleep mode”. This number entered must be greater than 10 minutes

In the above figure, the scanner is completely up to date with the latest revisions of the firmware, Altera, and LUT. If one of those items were not up to date, the corresponding item will change into a button:

![Laser Pro 16 Settings](image)

**Figure 2-2 – Updating the Radlink Scanner**

In the above figure, the firmware needs to be updated. To update the firmware, click “Click To Update Firmware” button. A dialog message will appear:
One should click “Yes” to proceed with the operation. During the firmware update process, the progress bar below the three boxes (or buttons) will show the progress of the update. When complete, the following message will appear:

![Scanner Update Directive](image)

**Figure 2-4 – Scanner Update Directive**

At this time, one must turn off the scanner and turn it on again. One should wait for the scanner to become “Ready” before clicking the “OK” button. The scanner is “Ready” when the LED marked “Ready” becomes lit.
One should then click “Save” to exit the settings screen.

The destination settings are shown above. The destination settings define each destination’s settings. It also has a field called “State” that instructs the software whether or not to send a DICOM image from the Radlink Scanner for each destination. Unchecking the State does not turn off communications to that destination, however. Again the state check box only controls output from the Radlink scanner for each destination.

**Active Destinations** – PACS hosts to receive images

**Inactive Destinations** – Removes hosts from the Active list

**Compression** – A variety of compression techniques are available.
The compression techniques supported are:
- **noCompression** – Save the image uncompressed.
- **jpeg2000Lossless** – Save the image using jpeg2000 wavelet lossless compression. The number of bits stored will automatically be the number of bits in the image at the time of the image save. The compression ratio to be expected is typically between 4 and 10 for jpeg2000 lossless compression.
- **jpeg2000Lossy** – This compression technique utilizes jpeg2000 wavelet lossy compression and achieves compression ratios between 10 and 70. The uncompressed images appear lossless in quality with this compression technique. JPEG2000 will perform 8, 12, and 16 bit compression.
- **jpeglossless** – This compression technique uses the common JPEG lossless compression algorithms. The number of bits in the compressed image can be set to 8, 12 or 16 bits. The compressed image typically have a compression ratio of about 5 to one.
- **jpeglossy – 8 bit Process 1** – This is JPEG 8 bit lossy compression. One can select a quality factor to control the quality and resulting compression ratio. The default quality factor is 90. (quality factor is set between 0 and 100). Rather good compression ratios can be achieved with this compression technique but at the expense of image quality. The uncompressed image will be 8 bit images of varying levels of acceptability.
- **jpeglossy – Process 2 & 4** – This is JPEG 12 bit lossy compression. Like jpeg 8 bit lossy compression, the quality factor can be set between 0 and 100. All of the compression algorithms described above are DICOM compliant and will be compatible with PACS servers supporting the DICOM standard for compression.

All of the above compression algorithms are supported for creating DICOM Part 10 CD’s. However, the default viewer with CD creation is only able to recognize jpeg 8 bit lossy and uncompressed images.

All hosts listed in **Active Destinations** will be sent the Radlink images as they are captured from the scanner. The **Inactive Destinations** will be ignored. If one selects a destination in either list box, the selection is automatically made in the **Destination Settings** combo box. The Destination Settings selection may also be preformed by using the Host **Alias** combo box.

**Destination Settings**

- **Host Alias** – A user chosen name of the PACS host. This name can be modified by selecting the text in the Host **Alias** combo box and retyping a new name. Changing the name will not impact DICOM communications. Its purpose is for a more friendly user interface. Note that the Host **Alias** names are the names the user sees in the **DICOM Spooler Host** combo box.
IP – Internet IP address. Usually a World Wide Web address, i.e. www.eradlink.com. IP can also be the physical network node address. The physical network node address of Radlink is 65.117.85.195.

Port – Port is the logical port of the PACS server. Radlink is currently using port 107. Other PACS host will have different port assignments.

Client Title – Client Title is the Client User Name. This field is ignored by most PACS systems.

Host Title – Host Title is PACS administered. It is case sensitive. Call your PACS administrator for the Host Title.

Protocol – The normal setting “Radlink” is based on the RSNA 2004 standard and is much richer in handling various modalities and PACS hosts. The Radlink protocol setting supports image compression. The older protocol is based on the RSNA 2000 standard. The protocol setting is "Mallinckrodt". This setting was added to accommodate older PACS systems. This protocol does not support compression and doesn’t support newer modalities.

State – A host may be placed in either an active or inactive state by checking this box. Only active destinations will be sent new scanner images. Changing the state to Inactive will not impact DICOM images currently in progress or queued for that destination. Those images will be sent until the queue is depleted.

#Retries – The router will give up and post an error alert if the transmission failed after that count of retries has been attempted. The default is retry 10 times.

Prompt on Send Failure? – An option to the router to not prompt on a send failure but rather place the DICOM image in the cancelled queue after a number of user defined retries. This is important for unattended operation.

Destination Settings Action Buttons

New – A new host is created by pushing the New button. A system generated Host Alias will automatically be generated and can be easily modified.

Delete – A host can be deleted by pushing Delete after selecting the destination to be deleted. If there are DICOM transfers in progress or queued up for that host, they will not be sent. No directories or files are actually deleted with this operation.

Dicom Ping – One should click the Dicom Ping button to ensure that the Destination settings, the network settings, and the PACS settings are correct and the PACS server is accepting associations. If all is well, the following message will be displayed:
If there are problems, the following message will be displayed:

![Figure 2-6 – Dicom Ping Success Message](image)

The most typical reason for the error message is incorrect IP and/or Port destination settings. The Dicom Ping button is also present in the Radlink Router destination settings.

**Router Settings**

The purpose of the Radlink Router Scheduler is to postpone Dicom uploads to after business hours.
When the checkbox is checked, the router will cease to send images except between the times selected.

Figure 2-8 – Radlink Router Scheduler
In the above example, the router will only transfer images to the PACS hosts between 5:45 PM and 11:45 PM.

**Listener Port** – The Listener Port is a port on the client machine that the Radlink Router listens to for “Send Status” button clicks. The Listener Port typically should not be changed. If the client already utilizes port 3000 in some other client application, this port setting should be changed to another available client port. If there is a port conflict, the router screen will not appear when the “Send Status” button is clicked. This port is also utilized by Image Acquire for sending images to the router.
The Raw File Format settings define the settings for reading a file with no header information. The Raw File Format defines the rows, columns, and depth of the raw bitmap image.

**Raw Format**

- **Rows** – Number of rows in a Bit Map file.
- **Columns** – Number of Columns in a Bit Map file.
- **Depth** – Indicates the number of gray scale bits (8, 12 or 15).
Figure 2-11 – Fire Wall Settings

The firewall information contains proxy server IP information that is necessary for routing images through the Firewall, if one is present. These settings are also present in your Internet Explorer browser and can be found by clicking Tools→Options and clicking the connections notebook tab:

Figure 2-12 – Internet Options Settings

To locate the firewall IP settings, click “LAN Settings…”.
Simply copy the Proxy server settings into the Radlink Fire Wall Settings. If no settings are present and you have a Firewall, contact your LAN administrator for the above settings.

It should be noted that the protocols being utilized by the Radlink system are TCPIP and SOAP. The SOAP protocol uses an extended HTML packet header for communications. Some firewalls do not allow HTML extensions. If that is the case, request your LAN administrator to configure the firewall to allow extended HTML packet headers.
“Cine Image Delay” is the number of milliseconds each image will be displayed in Cine mode. 100 is a typical number for this setting. “Repeat Count” is the number times the images will be displayed in a loop fashion.

Figure 2-15- Information Display Settings
The study information is displayed in the upper left side of the image display area when the “Show Selections” radio button is selected. The items in the study information is selectable by clicking the check boxes as shown above.

**Required Fields**

The fields on the “Patient Information Screen” can be set as “Required Fields” by the user of Image Acquire. The settings for required fields can be found by clicking the Settings→Required Fields menu item on the Image Acquire main screen:

![Required Fields Menu Item](image.png)

**Figure 2-16 – Required Fields Menu Item**

The following settings screen then appears:
The image acquire application will check for all fields checked above on the patient information screen to ensure that they have been completed. Previously only the “Patient Name” and “Patient ID” were required fields.

**Dicom File Settings**

Radlink performs image compression both in saving studies as well as sending to remote destinations. The following figure displays the compression settings associated with saving studies:
The compression techniques supported are:

**noCompression** – Save the image uncompressed.

**jpeg2000Lossless** – Save the image using jpeg2000 wavelet lossless compression. The number of bits stored will automatically be the number of bits in the image at the time of the image save. The compression ratio to be expected is typically between 4 and 10 for jpeg2000 lossless compression.

**jpeg2000lossy** – This compression technique utilizes jpeg2000 wavelet lossy compression and achieves compression ratios between 10 and 70. The uncompressed images appear lossless in quality with this compression technique. JPEG2000 will perform 8, 12, and 16 bit compression.

**jpeglossless** – This compression technique uses the common JPEG lossless compression algorithms. The number of bits in the compressed image can be set to 8, 12 or 16 bits. The compressed image typically have a compression ratio of about 5 to one.

**jpeglossy – 8 bit Process 1** – This is JPEG 8 bit lossy compression. One can select a quality factor to control the quality and resulting compression ratio. The default quality factor is 90. (quality factor is set between 0 and 100). Rather good compression ratios
can be achieved with this compression technique but at the expense of image quality. The uncompressed image will be 8 bit images of varying levels of acceptability.

**jpeglossy – Process 2 & 4** – This is JPEG 12 bit lossy compression. Like jpeg 8 bit lossy compression, the quality factor can be set between 0 and 100. All of the compression algorithms described above are DICOM compliant and will be compatible with PACS servers supporting the DICOM standard for compression.

All of the above compression algorithms are supported for creating DICOM Part 10 CD’s. However, the default viewer with CD creation is only able to recognize jpeg 8 bit lossy and uncompressed images.

**Overlay Settings**

Color and Font settings are provided for Calipers, Annotation, and Measurements. One changes the color by selecting the Menu Item **Settings → Overlays**:

The following settings screen then appears:

![Figure 2-17 – Overlay Settings Menu](image)
On the above screen there are Color and Font settings buttons for Annotation and Measurements and Color settings for the Calipers. When the “Edit” button is clicked in the Color column, the following screen appears:

Choose the desired color by clicking a color then click OK. The New Color button background color will then display the chosen color. One changes the fonts by clicking the button “Edit” button in the Font column. The following screen then appears:
The font picker displays all of the fonts, and font sizes in the system. Choose the desired font, font style, size, and font effects then click OK.

For this example the Annotation and measurements color and font have been changed to light blue and font of Vladimir Script:
One should then save the settings by clicking the save button.

Radlink settings can be protected with a password. To enable password protection for Radlink settings, simply change the password:

![Figure 2-22 – Changing the Settings Password](image)

The following screen appears after selecting the Change Password menu item:

![Figure 2-23 – Change Password Dialog](image)

After the password has been set, one must enter the password to change Radlink settings by logging into Radlink via the Login menu item. If the password is not entered upon Radlink startup, the "Settings" menu item will be disabled.
Chapter 3

Operating Instructions
Chapter 3: Operating Instructions

Startup

To start the *Radlink* software suite, double click the Radlink Image Acquire Icon on the desktop or click **Start** ➔ **Programs** ➔ **Startup** ➔ **Radlink Image Acquire** from the start button. The Main screen will appear (Figure 4):

Release Level

To determine which release of *Radlink* software you are working with, click on **Help** on the top toolbar then click on **About Radlink**. The release level will be displayed. This is a necessary piece of information if you place an inquiry with Radlink customer service.

User’s Manual

The content of this user’s manual is included in the application. Click on **Help** on the top toolbar then click on **User’s Manual**. This user’s manual will then be displayed in an internet browser. No connection to the internet is required, as the manual is installed with the Radlink application.

![Figure 3-1 – The Radlink Main Screen](image.png)
The menus are designed to enable the main Radlink screen to be operated without buttons. The menu items are:

The Main Screen is composed of four major sections:

1. “Sending” Information (Destination and Status)

2. X-ray image and series of X-ray image list.


   The four **Rotate** and **Flip** buttons allow for different views of the displayed x-ray.
   The **Scan** button activates the scanner causing the x-ray film in the scanner Film Input Tray to be scanned. The image is displayed line by line as it is scanned.

   The **Delete** button will delete the selected image in the image series list.

   The **Clear** button will delete all images on the screen.

   The **Send** button causes the x-ray image and patient information to be transmitted in DICOM file type to the listed destinations. While the images are being transferred to the listed destinations, the destinations will also appear on the list to the right.
When all DICOM transfers are complete, the list to the right side (Sending) will be blank:

The \textbf{W} and \textbf{L} sliders are for setting the Window and Level for the selected image. After a scan completes, the window and level settings are automatically computed and set. These settings can be overridden by moving the sliders. These settings are stored in the DICOM file header and are passed on to the PACS system. Most viewers will then open the DICOM image with these settings. The histogram below the window level sliders graphically displays the pixel distribution over the possible pixel values. For a 16-bit image, the maximum pixel value is 65536. For an 8-bit image, the maximum pixel value is 256.

Window/Level can also be set by using the mouse with the right button depressed and dragging the mouse over the image. Dragging the mouse horizontally will change the window setting. Dragging the mouse vertically will change the level. The sliders will move accordingly.

The Negative check box is for negating images. The following is what the images look like after checking that check box:

\begin{figure}
\centering
\includegraphics[width=\textwidth]{negative_check_box Effects.png}
\caption{Negative Check Box Effects}
\end{figure}

To the Right is a button called “Reverse Order”. The following figure shows the Reverse Order button:
Figure 3-3 – The Reverse Order Button

When the button is clicked, the order of the image list is reversed. This is shown in the following figure:
Figure 3-4 – The Reversed Image List

The Button to the right is a window level presets button. This button gives one three methods for setting the window level of an image being scanned. The first method is to use the “Automatic” window level to let the software determine the proper window level setting. This is the default setting and is the methodology used before this release. The second method is to not apply window level settings after the scan. This is the “None” setting. The third method is to set the window level based on user defined presets. One picks the method by clicking the button to the left as shown below:
When the button is clicked, the following menu is displayed:

Figure 3-5 – Window Level Presets Button

Figure 3-6 – Window Level Presets Menu
The menu items are split into three groups: Specific window level settings based upon user preferences, machine directives for window level settings i.e. Automatic or None, and Settings. If any choices are selected in the first two groups the selected image will be automatically window leveled to the choice selected. Please note that subsequent film scans will have this choice applied for the window level setting. The choice will be displayed as the text of the window level button as shown below for a choice of “None”:

![Figure 3-7: The effect of selecting None from the Presets Button](image)

The window level presets are all defaulted to window =0 and level =0 for all of the window level presets that are user definable (group 1 menu items). In order to set or change these settings, one should select the menu item, “Settings”. When that is done, the following screen appears:
One should select item to be edited by clicking on the desired line. In this example we chose Bone. The selected line then appears in the editable boxes at the top of the screen. The name of the item can be changed by typing into the input box called Text, and likewise the window and level can be changed by changing the input boxes for those two item respectively. One should then click “Save” to save the settings. When Save is clicked, the settings are saved and the settings screen disappears. To apply those settings, one should click the presets button again and select the desired preset. The following screen shows the screen as the preset bone is applied:
Figure 3-9: Applying a User Defined Window Level Preset

To simplify the task of choosing the numeric value for a user defined window level preset, one can simply window level an image and save it as a preset. To do this first select an image. Then window level it using the right button mouse and dragging it across the image until the desired window level setting is achieved. Then one should then click the presets button and click “Settings”. Then the desired preset line item should be chosen. Lastly to replicate the window level setting to that line item one should then click the “Get Current” button. One should then click save to save the settings and return to the main screen. To apply those settings to other images or images to be subsequently scanned, one should click the presets button and select the desired preset menu item.

The bottom icon buttons have pop up help to assist in identifying the functionality:
In the above figure, the mouse is held over the segment. In this example the message “Segment into Images” pops up.

**Scan**

To perform an x-ray scan:

Place the x-ray in the film input tray, top up, face out (only one x-ray at a time should be in the input tray).

Click on the **Scan** button on the main screen or press the **Scan** button on the scanner. The image will then be placed in the image series list and will be selected.

After the Scan is complete, fill in the patient information section.

**Send**

To send the series of files to other PACS hosts, click on the **Send** button. The destinations under **Send To** will receive the file.
The five file related menu items are Open Archive, Open Study, Save, Import, and Export. Open Study, Open Archive, and Save are used for opening and saving DICOM images. Import and Export are for importing and exporting foreign file types. The following screen shots explain how these menu items operate.
Figure 3-12 – Open Study

To open the exam for patient named “seriestest”, would select the exam for “seriestest” and click Open Files
Directory navigation is accomplished by clicking the Change Directory button.
One navigates to the desired directory with the standard Windows File Open Dialog shown in Figure 3-7.

Files can be sent directly from the archive or any other selected directory. To do this simply select the menu item File ➔ Open Archive or File ➔ Open Study from the Radlink main screen or select the File ➔ View Archive from the Radlink Router:

![Radlink Open Archive Files](image)

**Figure 3-15– View Archive Screen**

A filter has been added to assist in the rapid search of the desired study. Simply type the first character or two of the patient name and/or the first character of the patient id to narrow the scope of the studies displayed.
In the above example, the character “c” was typed into the patient name filter to narrow down the search to all patients whose name begins with “c”. After the study or studies have been located, select them and click the “Send” button to send them on to other PACS systems. The following dialog will be presented:
All of the destinations previously defined will be presented with check boxes. Check the destinations you wish to send the studies and click “Send”. The studies are then spooled to be sent to those destinations.

To open and view DICOM images that have been previously sent to PACS hosts, one should select the menu item File→Open Archive. This will bring up a open Study dialog as in Figure 3-4 above, pointed to the image Archive.

To save an Exam, click the File → Save menu item. The following dialog box will appear:

```
Figure 3-18 – Selecting a Save Directory
```

One navigates to the desired directory with the standard Windows File Open Dialog shown in Figure 3-8. To create a new directory for downloading, click “Make New Folder”.
Figure 3-19 - Creating and renaming a folder.

After creating the folder one should rename it and then navigate to it by clicking on it.

Figure 3-20 - Navigating to the newly created save directory

After the folder is created and selected for save, as shown above, Click the OK button.
To import and image into a study, click File → Import. Navigate to the desired directory as shown in the above examples. Choose the file type you wish to import and select the file. If the file type is unknown, choose “all files” in the file type combo box.

**Figure 3-21 – Importing Images**

In the above example, a JPG image called Sample has been selected for Import. Click Open to import the image.
Figure 3-22 - An Imported Image.
The image, as shown above, is then added to the exam. The image could be any standard JPG, PNG, TIF, etc. type image. The image could also be a scanned document that is to be inserted into the study for referring doctor exam documentation. When the exam is sent, via the Send button, the entire study, including the newly added image is sent as a package.

One can also export any image in the study. First select the image to be exported by clicking on the thumbnail for the desired image. Then click File→Export. The following dialog will appear:
One should select the file type and the compression technique desired. If the image is JPG, Compression Ratio is enabled for the JPG Lossy Compression technique. After selecting the options, click Save. The following dialog box will appear:

**Figure 3-24 – Image Save Dialog**
Choose any file name desired and click save. Note that the File Type is predetermined and cannot be changed. This file type was chosen in the previous step as shown in Figure 3-22.
A historical report of all studies read is produced by clicking on the menu item “Reports→Studies Completed” on the Radlink Image Acquire screen:

Figure 3-25 – Reports Completed Menu Item

When this menu item is clicked, a report of all studies read is displayed and can be printed’
While the report opens, the following dialog appears:

Figure 3-27 – Query Refresh Dialog

One should click the button “Enable Automatic Refresh”. This will ensure that the report has the current information.

Disk Management Screen
The Archive Maintenance screen is activated by selecting the menu item 
File→Database Maintenance.

The “Purge Files Older Than:” drop down list is the number of days that 
images will be retained in the Archive before being automatically deleted. 
This retention policy also applies to log file entries. Thus all logging entries 
older than that period will be removed as well.

The “Sync. Database” button should be used to synchronize the database 
tables based upon the current image directory contents. This action can be 
lengthy depending upon the number of images in the archive. The progress 
bar on the screen with a “number of files” counter displays the current status 
of the database synchronizing process.

The “Archive Directory” location can be changed by clicking the Folder Icon 
to the right. Changing the Archive location will automatically synchronize the 
database based on the new archive directory contents. Please note that this 
capability previously was located on the destination settings screen.

The “Backup Database” button will backup the SQL database. It is useful to 
periodically backup the database as most user settings are contained in the
database. The backed up database is called “Backup” and is located in the Radlink installation directory (Typically c:\program files\eradlink\backup”.

The “Delete + Restore Database” button is used to restore the database from a previous backup. The action deletes the current Radlink Database then restores it with the last backup. The backup file is called “backup” and is located in the Radlink installation directory. The database is automatically synchronized upon the completion of the database restore process.

The “Purge Old Files” button purges images and log file entries older than the retention period. This action is automatically performed upon Radlink application startup. It is also automatically performed once per day in unattended router operation.

Image Printing

![Image Printing](image.png)

Figure 3-29 – Radlink Print Menu Items
The print menu items are arranged in two groups. The first group is for postscript printing. Using the postscript requires that the printer be correctly configured. One does this by selecting Print Setup which will produce the following printer setup dialog:

![Printer Setup](image)

**Figure 3-30 – Printer Setup**

One should then select the printer using the combo box as shown above. To change the printer properties click Properties. The Properties dialog will permit you to change the print layout to “Landscape” or “Portrait” and also change other printer settings such as paper size, printer paper source, etc.

One should then set the image layout. To do this select Print Layout:

![Print Layout](image)

**Figure 3-31 – Print Layout**

The print layout describes the image placement. In this example there are to be 4 images per sheet of paper arranged in 2 rows and two columns.
One should then preview the images before printing by selecting Print Preview. The images will then appear just as they would if actually printed. One can now change the printer settings if necessary. One then actually prints the images by selecting the Print menu item.

One can send images to a DICOM printer by selecting the DICOM Print menu item. The following screen then appears:

![DICOM Print Dialog](image)

**Figure 3-32 - DICOM Print Dialog**

The figure above shows the settings that can be made for the DICOM Printer. One selects the DICOM printer by selecting the printer from the printer Combo Box. New printers can be created by clicking the button “New”. A printer can be deleted by first selecting the printer to be deleted then clicking the button “Delete”.

The Printer IP, Port and AE Title should now be entered. Note that the AE Title is typically case sensitive. After the Network settings are entered, one should test the connectivity to the printer by clicking the Printer Status button:
The printer should return with the NORMAL status. Click OK to return to the DICOM Print settings screen.

One should then enter the proper settings for all of the fields on the DICOM Print Dialog window. After entering the settings, one should click Save Settings to save the settings for that printer. After the settings are entered and saved, click Print to print the images. When the printing is complete, click Exit to return to the Radlink main window.

The following are the permissible settings for the DICOM Printer:

**Format:** This field specifies the layout of the images on the film. The numbers at the end are the number of rows and columns. The following are the permissible values:

- STANDARD\1,1
- STANDARD\1,2
- STANDARD\2,2
- STANDARD\2,3
- STANDARD\2,4
- STANDARD\3,3
- STANDARD\3,4
Cropping: These are Codonics “True Size” settings. Permissible values are:
- CROP
- DECIMATE
- FAIL
- NONE

The value NONE will make the Radlink software not to send the crop decimate DICOM tag. This choice was added to ensure compatibility with other printer manufacturers. The other values cause a new DICOM tag to be added. The tag is (2020,0040) CS. This instructs the Codonics Horizon printer to either crop if the image is bigger than the printable film size, decimate the image to fit the printable film size, or fail if the image is bigger than the printable film size respectively. This element gives “True Size” capability for images that are larger than the film size being printed to.

Priority: This is the print job priority. Permissible values are:
- HIGH
- LOW
- MED

Medium: This is the print medium. Permissible values are:
- BLUE FILM
- CLEAR FILM
- BWGen
- PAPER

Copies: This is the number of copies to be printed. Permissible values are from 1 to 100.

Film Orientation: The permissible values are:
- LANDSCAPE
- PORTRAIT

Film Size: The size of the film. Permissible values are:
- 4INX6IN
- 8INX10IN
- 8.5INX11IN
- 10INX14IN
- 11INX14IN
- 14INX14IN
- 14INX17IN
- 24CMX24CM
- 24CMX30CM
Film Destination: This is typically the bin that the film will be deposited into. Permissible values are:
BIN_1
BIN_2
BIN_3
BIN_4
BIN_5
BIN_6
BIN_7
BIN_8
BIN_9
PROCESSOR
MAGAZINE

Magnification Type: Permissible values are:
REPLICATE
BILINEAR
CUBIC
BICUBIC
MITCHELL
LANCZOS
SHARP1
SHARP2
SHARP3
NONE

Smoothing: Permissible values are:
MEDIUM
SHARP
SMOOTH
0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
**Trim**: This signifies whether or not to do cropping. Permissible values are:

- NO
- YES

**Min Density**: Permissible values are from 1 to 399.

**Max Density**: Permissible values are from 1 to 399.

**Empty Density**: Permissible values are from 1 to 399.

**Border**: This is the border color. Permissible values are:

- BLACK
- WHITE

**Polarity**: This is whether the image is to be printed as a negative or normally. Permissible values are:

- NORMAL
- REVERSE
The procedure for image acquisition should begin with filling in the study information.

One should first click the button (or menu item) “Patient Info. The following screen will then appear:

![Patient Information]

**Figure 3-34 – Patient Information**

The auto clear check box if checked will automatically clear the patient information upon a save study or send study event. If not checked, the information will persist and not clear from study to study.

The priority combo box sets the study priority that dictates its priority in the router send queue. This priority information is also passed along to PACS which will affect the priority of the study at that host.

Use the Search button to perform a “Modality Worklist” patient search, a “Remote PACS” patient search, or a “Local Database” patient search.
After the Patient Study Information is entered, one then presses exit and performs image scans by pressing the scan button. When the images are all scanned, one should then press the Scan button which will send the images to the PACS system.

The Patient Search screen will allow one to automatically fill in the “Patient Information” by using patient information in the PACS database. The following describes how to use this feature.

First click on the Patient Search button from the patient info screen. The following screen appears:

![Figure 3-35 – Search Screen](image)

One selects a PACS Host in the PACS Host list shown above, enters the appropriate search criteria for Patient Name, ID, and Sex then clicks the Query button.

In the above example there is no PACS Host listed. One must be created before the search can be accomplished. To add a PACS Host, click the Settings button.
The information below must be filled out. See your PACS administrator for the appropriate settings.

**Host Alias** – A user chosen name of the PACS host. This name can be modified by selecting the text in the Host Alias combo box and retyping a new name. Changing the name will not impact Dicom communications. Its purpose is for a friendlier user interface.

**IP** – Internet IP address. Usually a World Wide Web address, i.e. www.eradlink.com. IP can also be the physical network node address. The physical network node address of Radlink is 65.117.85.195.

**Port** – Port is the logical port of the PACS server.

**Client Title** – Client Title is the Client User Name. This User Name is typically administered by the PACS host.

**AE Title** – AE (Host) Title is PACS administered as well.

**Search Type** – This can be a Modality Worklist search or a PACS Patient search or a Local Patient Search. If the search type is Modality Worklist, the accession number will also be returned.
In the above example, the Host alias was changed to PACS Host. The IP of the PACS host is 127.0.0.1. The port for this PACS host is 108. The AE Title for the PACS server is PACS. The Client title for the Radlink client is Radlink in this example. Once the information has been entered, click on the Save button.

Select the appropriate PACS Host from the PACS Host list. This will be the host that will be searched for patient information. In the above example, there is only one PACS Host and it is selected. Next enter search criteria. For example if one typed
G in the Patient Name input box, all patients whose name begins with “G” will be returned. Then click on the Query button. In this example we will not enter any search criteria. All patients in the PACS database will be returned as shown in the following figure:

![Patient Search Results](image)

Figure 3-39 – Patient Search Results

Select the desired patient by clicking the left most column of the desired patient. In this case we will select GLENN with patient ID 1. After the appropriate patient is selected push Select to enter that patient’s information in the Radlink patient information fields or push Cancel to retry the search.
In the above example, the Patient name, sex, birth date, and patient ID are populated with the results of the patient search.

One can also perform patient searches in the Modality Worklist.
Figure 3-41 – Patient Search Screen

One should first click the Search Button on the Radlink screen to bring up the Patient Search Screen shown above. The PACS Host list is able to accommodate both patient searches as well as modality worklist searches. One creates a modality worklist host by clicking Settings:

Figure 3-42 – Modality Worklist Search Settings
One should then fill in the IP, Port, Client Title, and AE Title. One then should select either “Patient Search” to do patient searches, or “Modality Worklist” for Modality Worklist searches.

![Figure 3-43- Search Type Settings](image)

One should then click save to exit the screen and save the settings. Assuming Modality Worklist was chosen for “Host2.

If worklist entries are found, the following screen will appear:
One then selects a patient from the worklist and clicks Select. The Patient information is then filled out in the Patient Information area of the Radlink screen:
Notice that the accession number is then filled in. Modality Worklist items must contain an accession number.

The third patient search supported is “Local Patient Search”. This search technique utilizes a client side patient database. The population of this database is performed by clicking the save button on the patient Information screen.
The fourth patient search supported “Local Modality Worklist”. To utilize this search type one should change the settings on the Radlink Patient Search screen:

The Host Alias, IP, Port, Client Title, and AE Title fields are ignored for this (as well as Local Patient) search. When the search is performed, the system will load the file “C:\Documents and Settings\All Users\Documents\eradlink\patients.xml” file. This file contains the information for all patients returned in the patient info search screen.

The file can be dynamically loaded or altered by applications external to the Image Acquire application. The file format is xml. The following is an example Patients.XML file that contains two entries:

```xml
<?xml version="1.0" encoding="utf-8"?>
<ArrayOfPatient xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <Patient>
      <name>1</name>
      <accession />
      <id>1</id>
      <birthdate>20040324</birthdate>
      <sex>M</sex>
      <examDate>20040423</examDate>
   </Patient>

   <Patient>
      <name>2</name>
      <accession />
      <id>2</id>
      <birthdate>20050423</birthdate>
      <sex>F</sex>
      <examDate>20050523</examDate>
   </Patient>
</ArrayOfPatient>
```

Figure 3-46 – “Local Modality Search”
Please call Radlink support if there are any questions on the file format of the patients.xml file. All fields must be present in each patient. The date fields must follow the DICOM date format rules of YYYYMMDD. If the day or month is one digit, force it to be two digits as shown above, for example, April 23, 2004 is formatted as 20040423.

The permissible values for the priority field are: blank, 0, 1, 2, where 0=normal, 1=high priority, 2=low priority.

When the patient info “Query” button is clicked, all patients defined in that file will be displayed. The patient information fields will then be subsequently automatically filled out with the field values contained in that file. This is an alternative implementation of the modality worklist search that doesn’t require the rigid DICOM Modality Worklist Communication protocol.
In the above figure, the Search type is set to “Local Patient Search”. IP, Port, Client Title, and AE Title parameters are ignored.

The query techniques are similar to PACS Patient Search and Modality Worklist Search. The following is an example query:

In the above figure, a query for all patients whose name starts with “W” is specified.
As shown above, all patients whose name starts with “W” is returned. One should select the desired patient by clicking the “Select” button. The Patient information is then populated on the Radlink Main Screen. If the patient is not listed, one should click cancel. One then must manually enter the patient information on the Radlink Acquire screen. When the study is sent, that patient information will be added to the database for subsequent retrieval.

The “Station Name” drop down list is populated with the contents of an XML file that is user provided. If this file is not provided, the operator can simply type the station name into that Combo Box.
Figure 3-50 – Patient Information Screen

The station name field is a “sticky value” field and will be automatically populated with the last value entered.

The format of the xml file would look like:

```xml
<?xml version="1.0" encoding="utf-8"?>
<ArrayOfStationName xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
  <StationName>
    <name>AE_LAPTOP</name>
  </StationName>
  <StationName>
    <name>Another Station</name>
  </StationName>
</ArrayOfStationName>
```
The above example file has two station name entries: AE_LAPTOP and "Another Station". The file name is to be called StationNames.xml and is to be located in the eradlink folder which is in shared documents.

The file format of the StationNames.xml is a Industry Standard and can easily be read, created, or modified with Microsoft Excel or any other program which supports this standard.

Please note that if either Study Date or Birth Date have been set as required fields the following behaviors will occur upon the click on the Save or Save and Exit button::

  **Study Date** – If the date entered is “Today’s Date” and error alert will be presented.
  **Birth Date** – If the date entered is “Today’s Date” and error alert will be presented.
Segmentation

There are now three buttons associated with the segmentation procedure. “Display Template” displays the chosen template on the screen. “Segment” will segment the image according to the chosen template. “Resize Template” will start the template resize process.

The thing one should do is to click the button “Display Template”. After clicking the button, the button becomes a “Hide Template” button for later hiding the template.

![Figure 3-50 – MRI With Template Visible](image)

The next step is to Resize the Template (if necessary) by clicking the “Resize Template” button. Resizing the template is a two step procedure. First one positions the template then resizes it.

When the Resize Template button is clicked, the chosen template should be moved to the proper position on the image. Position the template on the upper left of the image. When positioned properly, Left click the mouse ONCE. The template is now in resize mode and the size of the template will follow the mouse.
One should then navigate to the lower right of the image. If the image is too large for the display, use the scroll bars on the image to make lower right corner of the image visible. When the template is resized properly, click the left button of the mouse ONCE. This finishes the template resize procedure.
Note that in the above figure, the image has been scrolled to make the bottom right corner visible. Also the left mouse button is about to be clicked when the template is aligned properly on the bottom right side of the image.

One can now segment the image by clicking the Segment button. After segmenting the image, one should hide the template by clicking the Hide Template button. To enlarge the segmented images, click the zoom drop down. Perhaps 150% is the proper size for viewing.
One can now click the “CINE” button to see the segmented images in a Movie-Like fashion. The CINE settings can be adjusted by clicking the menu item, Settings→Cine.

The following cine settings screen appears:
“Cine Image Delay” is the number of milliseconds each image will be displayed. 100 is a typical number for this setting. “Repeat Count” is the number times the images will be displayed in a loop fashion.

After the study has been read with the viewer, a study report can be completed and sent.
Figure 3-56 – Completed Patient Report

The above figure displays a patient document (shown using Microsoft Word) created with the patient results document creation facility. One creates a document by clicking the menu item: View→Patient Report.
To create a report, click the menu item File→New. The following screen appears:
The Institution and Services fields are persistent and only have to be entered once. After entering those fields, one selects the exam that is to be documented by clicking the Exam button. The follow screen then appears:

![Image of Create Patient Report Screen]

**Figure 3-58 – Create Patient Report Screen**

The Institution and Services fields are persistent and only have to be entered once. After entering those fields, one selects the exam that is to be documented by clicking the Exam button. The follow screen then appears:
Figure 3-59 – Study Selection Screen

One then selects the study to be documented and then clicks “Exit”.

[Image of the Study Selection Screen]
Figure 3-60 – Filling out Study Results

If a second body part was examined as part of this study, one should select the body part in the Add Body Part drop down list. One can also type one in if needed. After the selection is made, one should click the button, “Add Body Part To Report” button. The description and impression for that body part should then be displayed. One can also modify the description and impression for a custom report.
Now that the study information has been entered, one clicks “Exit”. Note that no typing was performed in this example.
The report is then shown. To save the report in Microsoft Word (any document editor that supports “RTF (Rich Text Format)” click the menu item File→Save. Then enter the file name for the report and click save. One can now send this report as an attachment in an email to complete the Study Report Documentation process.

One can also add body parts to the drop down menu lists for future use by clicking the “Edit Body Parts” button. When that is done the following screen will appear:
One can delete a body part from the list by selecting the body part and then clicking the right button. A delete Menu item will appear which one selects to delete the body part from the list. One adds a body part to the list by typing the body part name in the body part input text box then clicking the “Add Body Part to List” button:
After the body part is added, one should add the default normal impression and Description for the body part. After the list is edited, one should click the “Save” button. Click the “Exit” button to cancel and exit this activity.

After the body parts list is edited and saved, it is reused in both the Radlink Image Acquire main screen (the body parts drop down list) and on the create patient reports body parts drop down list.

NOTE: When the list is edited, the file containing the list should be distributed to others using the Radlink System so they will have the same body part drop down choices. The file is named "normalBodyParts.xml" in the eradlink program files directory (usually located in “C:\Program Files\eRadlink”.

ALSO NOTE that is preferable that the Radlink Acquisition Station have the same normalBodyParts.xml file. If the technician scanning the films chooses a body part from the drop down list and the list is the same as the Radiologists reading the study, work will be saved as the normal template body part impression and description will be automatically filled in during the report creation process.
The menus are designed to enable the main Radlink screen to be operated without buttons. The menu items are:

- **File**
- **Settings**
- **View**
- **Tools**
- **Reports**
- **Twain**
- **Login**
- **Help**

The File menu items contains the item “Retrieve Study”. This menu item has two sub menu items: “Radlink” and “PACS”. The Radlink menu item retrieves images from the Radlink Image Express server. Pacs, which will be supported in an upcoming Radlink release, retrieves studies from a selectable PACS server.

1. Exams can be burned to CD with Radlink Image Acquire. The images scanned and saved by the Radlink Image Acquire application are burnable to CD using this facility. To launch the CD Burner software, one should either select the menu item File→Open Archive or File→Open Study menu item:
Choosing the Open Archive menu item brings up the following screen:
One can select multiple exams by clicking the arrow on the left column of the exam and dragging the mouse vertically. The following is a set of exams about to be burnt to a CD:

![Figure 3-67 – Selecting Exams for CD Burning](image)

One should then click the Burn CD button. The system will then prompt you for CD label information. This should be the label that is on the CD Case. If the label is to be saved into the Radlink database, click the "Save Into Database" button. The CD Label Database is used to retrieve studies from the CD Archive. If one does not wish to save the Label information into the database, he should click the button “Cancel”.

![Figure 3-68 – Entering the CD Label](image)
After clicking “Save Into Database” the file copy to the CD process then begins:

![Figure 3-69 – Adding Files to the CD](image)

One should ignore the windows pop up balloon that indicates that files are being written to the CD.

![Figure 3-70 – Windows CD Prompt](image)

When the files are all added to the cd a CD Burner window will appear:
Figure 3-71 CD Writing Wizard

One should enter a name for the CD and click the button "Next".

Figure 3-72 – Burning the CD
When the burning process is finished, the CD will automatically eject. One can then view the exams by inserting the CD. The Radlink viewer will then be invoked:

![Figure 3-73– Patient List](image)

The Exam should then be selected by checking the check box to the left of the exam folder. Then one should click the Button “Load”. The exam can then be viewed:
Figure 3-74 – Viewing the CD Exam

One can also view the exam using the Radlink Image Acquire application. One should start the Image Acquire application the click “Open Study”. Then click the Change Directory button and navigate to the CD:
Figure 3-75 – Opening an Exam With Radlink Image Acquire

After navigating to the Exam on the CD, click OK. Then select the Exam to open and click Open Selected Study.
One can choose their own viewer to be burned to the CD rather than the Radlink provided viewer by changing the settings in Image Acquire. The settings can be opened by clicking the menu item “Settings → Dicom File Settings”.

Figure 3-76 – Viewing the Exam With Radlink Image Acquire
To utilize a different viewer when burning a CD, enter the full path name of a viewer to burn rather than the Radlink provided viewer. Entering in the full path name is facilitated with the folder button to the right, which brings up a file navigation screen.

The Image Acquire application can now save exams in Part 10 Format. This feature should not normally be used. To turn on the feature, check the “Part 10 Format” check box. All images saved by Image Acquire will then be saved in Part 10 Format. Part 10 Format images have a different DICOM header and file naming convention. A DICOMDIR file is also generated when the Exams are saved. All exams burned to a CD with the CD Burner facility are in Part 10 format.
2. We have added a CD Archive Database, which will enable one to index the CD’s into the CD Archive for easy retrieval. One can now age off DICOM studies from the Image Archive onto CD’s and later retrieve the studies from the CD’s with the CD Study Database.

To view the archive, click the button “CD Archive” on the “Open Archive” or “Open Study” screen:
Figure 3-79 – “CD Archive Button” on the Open Archive Screen

After the button is clicked, the following screen appears:
The screen lists all studies in the CD Archive, sorted by Name. The list can also be sorted by ID, or Study Date by making the desired selection in the Sort Combo Box:

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
<th>Sex</th>
<th>Birthday</th>
<th>Study ID</th>
<th>Study Date</th>
<th>Specialty</th>
<th>Description</th>
<th>CD Label</th>
<th>Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARTER, SHIRLEY</td>
<td>10 75-60</td>
<td>F</td>
<td>8/17/1970</td>
<td>10/7/2004</td>
<td>DC</td>
<td>COUGHLING FRAH</td>
<td>LINDEN MEDICAL</td>
<td>GLENDALE, BACK PATH</td>
<td>Volume 10</td>
</tr>
<tr>
<td>CAPPELLA, MIKE</td>
<td>79502 19940</td>
<td>M</td>
<td>5/16/1927</td>
<td>2/17/2004</td>
<td>CT</td>
<td>Abdomen 3 DUAL PLAN</td>
<td>Open System Imaging, Pain</td>
<td>Volume One</td>
<td></td>
</tr>
<tr>
<td>COHEN, HANINE</td>
<td>136344</td>
<td>F</td>
<td>11/11/1969</td>
<td>9/1/2004</td>
<td>CT</td>
<td>ABD PAIN</td>
<td>SANDERSTON HOSP. HOSP.</td>
<td>Volume Two</td>
<td></td>
</tr>
<tr>
<td>DANZ, HANSE</td>
<td>599200</td>
<td>M</td>
<td>5/13/2001</td>
<td>9/13/2001</td>
<td>CT</td>
<td>LT FLANK PAIN</td>
<td>VUMC HOSP. CT</td>
<td>Volume 10</td>
<td></td>
</tr>
<tr>
<td>DETERO, ALEJANDRO</td>
<td>205105</td>
<td>F</td>
<td>12/25/1952</td>
<td>4/13/2004</td>
<td>MNR</td>
<td>LEFT HIL</td>
<td>Premier Imaging</td>
<td>Volume 10</td>
<td></td>
</tr>
<tr>
<td>GONZALES, ELENA</td>
<td>318039</td>
<td>F</td>
<td>4/6/2004</td>
<td>US</td>
<td></td>
<td>INNSBRUCK MEDICAL STATION</td>
<td>Volume 10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-81 – CD Archive “Study Sort” Combo Box

The CD Archive studies can also be filtered. One can choose to display all patient studies by the starting letters of the patient name and/or all patient studies by the starting characters of a given patient ID.
After the desired study has been located, the CD Label is displayed on that row. This is the label of the CD on the shelves of the CD Library.

3. One can export the CD Archive Information to a tab delimited test file by clicking the “Export” button. After the file has been exported, it can be imported into programs such as Microsoft Excel for report generation.

4. After the studies have been aged onto CD’s, the can be deleted out of the Radlink Image Archive by opening the Image Archive, selecting the desired studies, then clicking the “Delete Study” button:
Figure 3-83 – Deleting Studies from the Radlink Image Archive
Figure 3-84 – Selecting the Twain Paper Scanner

After the scanner is selected, one should then click the menu item “Twain→Acquire” to begin the scan preview and scan process.

The paper scan is then attached to the study in Dicom Format:
One can retrieve studies resident on PACS for viewing or other usages such as CD Burning. To retrieve a study click File→Retrieve Study→PACS menu item on the Radlink Image Acquire screen. The following screen appears:
One must first enter the settings for PACS study retrieval at both the client side as well as the PACS system.

The following parameters need to be entered:

- **PACS IP** – This is the IP of the PACS server.
- **PACS Port** – This is the port the PACS server listens for requests. Typically the port is port 104.
**Client Title** – This is the name that the PACS system will need to return the requested study.

**Receive Port** – This is the port that the PACS system will return the study on. The port number must be unique to the client machine.

Once the client side settings are entered, one should click the button “Ping”. This will send a DICOM Ping to test connectivity to the PACS server.

To set up the PACS server, a destination will need to be added. This is the destination corresponding to the Client machine that requested the study (the Radlink System). To do this on Centricity one first opens that application. Then select the menu item Connection → Destinations. The following screen appears:

![Figure 3-88 GE Centricity Destination Settings Screen](image)

In the above figure, the defined destinations are displayed. To enter a new destination, click “Add”. Enter the client side information such as IP, Port, and AE_Title information (this should match the client information entered in the Radlink System). The information for this example is as follows:
The Connection parameters are:
One should note that the Host name is the IP address of the Radlink Image Acquire workstation. The port is the port specified in the Radlink settings described. The DICOM AE Title is the “Client Title” entered on the Radlink system.

After the communications settings are input, one can now perform the Radlink Study Query Retrieve. Click the Query button to get a list of all studies on the PACS server. To filter the number of entries returned, enter the first couple of letters of the patient name and/or the first character or two of the patient ID, and/or the study date from/to information. The following is an example of study information returned after clicking the query button:
One should select the desired study and click the button “Retrieve Study”. The study will then be downloaded to the Image Archive directory and subsequently brought up on the Radlink Image Acquire Screen:

![Figure 3-92 – Study as Retrieved From Centricity]
Annotation
One annotates an image by clicking the “Annotate” button then clicking the position on the image where the text is to be located. A black input field will then appear at that location. Type the desired text into that input field:

Figure 3-93 – Creating an Annotation

One should then tab out of the input field. The following is the result of tabbing out of the input field in the above example:
Measurements
One measures an image by clicking the "Measure" button then moving the cursor to the start point of the measurement. Press the left button on the mouse and keep it depressed until the measurement is completed. Move the mouse to the desired end point and release the left button to complete the measurement. The measurement line will follow the mouse with a rubber-band like effect. The measurement text is dynamically updated as well.
The measurements are in millimeters and are displayed with the font selected in the Overlay Settings screen. Please note that measurements and Calipers are only displayed for DICOM images that have the DICOM element: (0028,0030) Pixel Spacing included. This DICOM element contains the number of millimeters per pixel in both the horizontal as well as vertical directions.

**Zoom**

One “zooms” and image by clicking the zoom button then selecting the desired magnification:
A zoom window then appears:

Figure 3-97 – Image Zoom
The upper left corner of the zoom image corresponds to the mouse position. As one moves the mouse, the image changes accordingly.

**Calipers**
One can turn the Calipers on or off by selecting the menu item “View→Show Calipers”.

![Figure 3-98 – Displaying the Calipers](image)

The calipers are 10 millimeters per division. This tidbit is displayed in the patient info box at the upper left of the image. This dimensional information is important for documentation purposes.

**Series Support**
One can navigate to a desired series or image by clicking the appropriate Series or Image buttons on the screen. Using the above example, the Next Series button was clicked:
The image list is then changed to show all images for that series. When one clicks the CINE button, all images in the selected series will be displayed in a Movie-like fashion.

One can create a new series which is placed at the end of the study by clicking the “Create Series” button. This is extremely useful for segmentation of films each in a separate series, thus properly emulating the modality that generated the films. The following exemplifies this procedure.

Assume one has two films that are to be segmented. One should scan in the film and select the proper template:
One should then click the “Segment” button, which will segment the film as it originally came off of the CT modality. These images would then go into series number one:
The next step would be to create a new series by clicking the “New Series” button. One should then scan the next film and choose the appropriate template:

![Figure 3-101 – CT Film Scanned into a New Series](image)

One then segments that image by clicking the Segment button:
Now when the CINE button is clicked, only the images for the series is displayed as opposed to all images in the study as was the case before Radlink Release 4.2. The images will also be displayed properly at the remote PACS viewer after they are sent, with the images broken into the proper series.
DICOM Router

To view the router settings, one should either click on the Status button located on the Radlink Image Acquire screen, or click the Router icon in the system tray at the lower right of the screen. The following screen will then appear:

![Figure 3-103 – The Radlink Dicom Router](image)

One should then click the menu item Edit → Settings for the router settings screens.
A Quick overview of the setup steps:
The instructions layout the necessary steps, to set up the router.

1. One must first create all of the destinations that the router, or Image Acquire, may want to send Dicom images.

2. One then sets up all of the various modalities. It is important that modality have a corresponding default destination. Also each modality must have a unique modality AE Title.

3. Lastly, one should enter the rules that govern the router. If no rules are entered, or no rules apply, the default destinations will be chosen for the route.

The rules override the default destinations. If a rule applies, the destination within that rule will be chosen instead.
Each rule contains its own set of destinations. If more than one rule applies, then each of those destination sets for those rules will be sent Dicom Images.

The rules are not specifically tied to a particular modality. A rule can contain one or more modalities and specify one or more destinations.

The Router also contains a log for all messages received and which rules were applied.

The Router includes a rules tester which will facilitate the debugging of all of the rules that are in the system.

One first clicks the Destination Tab to enter the destinations:

![Figure 3-105 - Router Destinations Setup Screen]

Figure 3-105 - Router Destinations Setup Screen
Destination Settings

**Host Alias** – A user chosen name of the PACS host. This name can be modified by selecting the text in the **Host Alias** combo box and retyping a new name. Changing the name will not impact DICOM communications. Its purpose is for a more friendly user interface. Note that the **Host Alias** names are the names the user sees in the **DICOM Spooler Host** combo box.

**IP** – Internet IP address. Usually a World Wide Web address, i.e. www.eradlink.com. IP can also be the physical network node address. The physical network node address of Radlink is 65.117.85.195.

**Port** – Port is the logical port of the PACS server. Radlink is currently using port 107. Other PACS host will have different port assignments.

**Client Title** – Client Title is the Client User Name. This User Name is typically administered by the PACS host. Please call Radlink for your Radlink client title.

**Host Title** – Host Title is PACS administered as well. The Radlink Host Title is PACS.

**Protocol** – The normal setting “Dicom 3.0” is based on the RSNA 2004 standard and is much richer in handling various modalities and PACS hosts. The “Dicom 3.0 protocol setting supports image compression. The older protocol is based on the RSNA 2000 standard. The protocol setting is "Mallinckrodt". This setting was added to accommodate older PACS systems. This protocol does not support compression and doesn't support newer modalities.

**Prompt on Send Failure?** – An option to the router to not prompt on a send failure but rather place the DICOM study in the cancelled queue after a number of user defined retries. This is important for unattended operation.

**Compression** – A variety of compression techniques are available.

The compression techniques supported are:

- **noCompression** – Save the image uncompressed.
- **jpeg2000Lossless** – Save the image using jpeg2000 wavelet lossless compression. The number of bits stored will automatically be the number of bits in the image at the time of the image save. The compression ratio to be expected is typically between 4 and 10 for jpeg2000 lossless compression.
- **jpeg2000Lossy** – This compression technique utilizes jpeg2000 wavelet lossy compression and achieves compression ratios between 10 and 70. The uncompressed images appear lossless in quality with this compression technique. JPEG2000 will perform 8, 12, and 16 bit compression.
**jpeglossless** – This compression technique uses the common JPEG lossless compression algorithms. The number of bits in the compressed image can be set to 8, 12 or 16 bits. The compressed image typically have a compression ratio of about 5 to one.

**jpeglossy – 8 bit Process 1** – This is JPEG 8 bit lossy compression. One can select a quality factor to control the quality and resulting compression ratio. The default quality factor is 90. (quality factor is set between 0 and 100). Rather good compression ratios can be achieved with this compression technique but at the expense of image quality. The uncompressed image will be 8 bit images of varying levels of acceptability.

**jpeglossy – Process 2 & 4** – This is JPEG 12 bit lossy compression. Like jpeg 8 bit lossy compression, the quality factor can be set between 0 and 100. All of the compression algorithms described above are DICOM compliant and will be compatible with PACS servers supporting the DICOM standard for compression.

If the destination chosen is eRadlink, the compression options are “No Compression”, “JPEG 2000 Lossy Compression”, and “JPEG 2000 Lossless Compression”.

![Figure 3-106– Image Compression Options](image)

---

**Figure 3-106– Image Compression Options**
The following figure shows an example list of destinations entered for our example:

![Figure 3-107 – Router Destinations](image)

One then proceeds to the Modalities setup screen by clicking on the Modality tab.
Figure 3-108 – Router Modalities Setup Screen

One should then enter port information and default destinations for each of the modalities that will be routed.
The Name Combo box is the Radlink user defined name for the modality. The Hosts list is a list of destinations that the Radlink system could forward the DICOM image to. To instruct the Radlink system to forward the image to a host destination, check the check box for that destination.

The above figure shows a modality that has been configured to send to the destinations Radlink and LOCAL PACS. One could also send the image to the Dr. Jim Bob by selecting it as well in the above example.

The port setting is the port that the Radlink system will use to receive the DICOM images from that modality. The modality should be configured to send to the IP that is defined on this machine, the machine housing the modality router.
The AE title at the sending modality must be set to the Router AE Title. The port setting in the example above is 1005. There cannot be duplicate modality AE Titles and the modality ports cannot conflict with other port settings within the machine. The range of ports that can be assigned are from 1 to approximately 65,000.

To set up other modalities, follow the above procedure for adding and configuring a modality. One could configure two different modalities to send to the same Radlink modality port by configuring those modalities to send to the same Radlink port.

Note that if the Radlink DICOM Router is shut down, the Radlink system will not be able to receive images. The Radlink DICOM Router is started up automatically upon machine startup.

The next step is to enter the rules. One should now click the Rules tab.

![Figure 3-110 - Radlink Router Rules Page.](image)

To edit a rule, highlight the rule in the Rules List and click edit. One can also delete a rule by highlighting the rule and clicking Delete Rule. To create a rule, click the Create Rule button.
One should select the all of the modalities that this rule addresses. Then one should select the destinations. If the rule is to route based on DICOM information, enter that information as well. If the rule is to apply at specific times, that should be entered as well. To specify the times, select a time range item in the combo box. The following are the choices:
Figure 3-112 – Date Range selection choices

For this example between Date Times is chosen:
Figure 3-113 – The Jim Bob Rule

As the rule is being formulated, the English translation is displayed at the bottom of the screen. Another example rule is:
Figure 3-114 – Recurring Day Rule

The completed list for our example is as follows:
To read though the rules in a convenient manner, click the rule filter to just see the rules by a particular modality or a particular destination:
Figure 3-116 – Rules filtered by modality

The rules filtered by destination look like this:

Figure 3-117 – Rules filtered by Destination
One can view the status of all messages entering the router and which rules were applied by clicking the Router Status tab.

![Router Modality Message Log](image)

**Figure 3-118 – Router Modality Message Log**

The Modality combo box should be used to select the modality log for the desired modality.

To test the rule sets, simply click the Rules Test button. This will simulate sending a message to the router and applying all of the rules against it. The Dicom file utilized in the test is “Test.DCM”. This file is located in the “Modality InBox” directory, which is located in the program files directory for Radlink. You may replace this file with any Dicom File. The file must be renamed to Test.DCM, however.

To view the files that are being sent to the various destinations, close the Router Screen to return back to the following screen:
Figure 3-119 – Radlink Router Destination Status Screen

All files being sent are routed through the **DICOM Router**. The status of the image may be viewed by displaying the **Router Status** window. To display the window, click on the **Radlink Icon** on the lower right corner of the computer screen.

The status bar gives a instant look at which modality is currently sending to the Radlink Router, which PACS host the router is currently sending to, and how many images have been sent to the cancelled directory due to transmission problems. In addition, the sending status is broken down to not only show activity, but to display exactly what the router is doing during the image send. The possible send status states are:

- **Preparing Images** – This indicates that the router is compressing the images for transmission.
- **Sending Images** – This indicates the router is currently sending the study. The progress bar at the top of the screen shows the progress of the transmission for each image being sent in the study.
- **Retry In Progress** – If a transmission occurred, the Router will retry the send for a user defined number of times.
- **Send Complete** – The study has been sent successfully.
- **Moving Images to Archive** – The images are being moved to the image archive. This message occurs after a successful send if the check box “Archive?” is checked on the destination settings screen. If this check box is not checked, the images are simply deleted after the successful send.
Deleting Images – The image are deleted after a successful send if the check box “Archive?” is not checked.
Send Aborted – If the user checks the button “NO” in response to the dialog box asking the user if he wants to retry the study send, this status is given.
Finished – The send operation has been totally completed.
Senders Idle – The Senders are idle and not sending images.

![DICOM Router showing Resend and Delete Files Buttons on the Cancelled Screen](image)

Compression/Decompression is also supported by the Radlink Router. One should set the compression algorithm for each destination to perform the compression:
As messages are received into the Radlink Router, they are decompressed. The compression algorithm specified for each destination is then inspected. If the Depth in the settings is less than the depth of the received image, that depth setting and compression algorithm is utilized, otherwise the compression algorithm specified and the Depth of the incoming image is used for the outgoing compression.

One can simply receive, archive, and not send an image sent to the Radlink Router. Simply set up a Modality that the router is to receive images from and then select the Archive No Forward option:
Images will then be received and archived, but not forwarded to any destination.

Changing the priority of a study is accomplished by first clicking on the desired study then changing the priority by clicking on the “Study Priority” combo box and choosing one of the three priorities:
Multiple PACS hosts are supported in the Radlink DICOM spooler. One can view the status of the DICOM transfers for a particular host, by selecting the host on the leftmost combo box in the DICOM router screen. All of the operations mentioned above are available for each individual host in the combo box. Note the communications are concurrent. Multiple destinations are sent images concurrently. Also, one host could be paused while another is transferring. In addition, the DICOM Transfer Progress bar displays the file transfer status (percent complete) for the particular host selected in the host combo box.

The status of the host is displayed at the top of the file list. The two settings are “Active” and “Not Spooling Images”. “Not Spooling Images” means that the host has been set Inactive in the Radlink application. When an image is scanned and sent, it is only sent to Active Hosts. The image will be sent to all hosts marked as active.

One can view the history and status of all sent images by selecting “Sent” in the Queue combo box.
The above figure is the status of all files sent to the host with host alias “efilm”. The list of files can be sorted by clicking on the column header. The list can be sorted on any column, ascending or descending. The following figure is the same list sorted by time in ascending order:
Log files are generated to track the activity of the Radlink Router. There is one log file for each DICOM destination. The log files can be easily imported into Microsoft Excel for formatting and subsequent printing. The file name of the log file is “Radlinklog-<host alias>.txt” where <host alias> is the user defined name for the DICOM destination. These log files are placed in the Radlink.exe home directory, which is typically c:\program files\eradlink. Note that columns are tab delimited for ease of use in Microsoft excel. The following is an example report formatted in Microsoft Excel:

<table>
<thead>
<tr>
<th>Patient Name</th>
<th>UID</th>
<th>PACSIP</th>
<th>PORT</th>
<th>File Name</th>
<th>Status</th>
<th>Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.60.563</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.63.976</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.65.723</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.66.441</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.67.276</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.68.605</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.69.920</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.70.986</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.71.136</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.72.871</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.73.676</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.74.361</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.75.851</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.76.457</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
<tr>
<td>seriestest</td>
<td>123</td>
<td>1234</td>
<td>1.2003</td>
<td>4.1.8.52.77.756</td>
<td><a href="http://www.eradlink.com">www.eradlink.com</a></td>
<td>100</td>
</tr>
</tbody>
</table>
A status column is included to indicate the success/failure of the DICOM send. The Radlink Router has been modified to display most of this log file information.

Lastly, an interface for perform Radlink Archive Database Maintenance functions is provided. This screen is activated by clicking the menu item **File→Database Maintence:**

![Radlink Archive Maintenance](image)

**Figure 3-127 – Radlink Archive Maintenance**

The “**Purge Files Older Than:**” drop down list is the number of days that images will be retained in the Archive before being automatically deleted. This retention policy also applies to log file entries. Thus all logging entries older than that period will be removed as well.

The “**Sync. Database**” button should be used to synchronize the database tables based upon the current image directory contents. This action can be lengthy depending upon the number of images in the archive. The progress bar on the screen with a “number of files” counter displays the current status of the database synchronizing process.

The “**Archive Directory**” location can be changed by clicking the Folder Icon to the right. Changing the Archive location will automatically synchronize the
database based on the new archive directory contents. Please note that this capability previously was located on the destination settings screen.

The “Backup Database” button will backup the SQL database. It is useful to periodically backup the database as most user settings are contained in the database. The backed up database is called “Backup” and is located in the Radlink installation directory (Typically c:\program files\eradlink\backup”.

The “Delete + Restore Database” button is used to restore the database from a previous backup. The action deletes the current Radlink Database then restores it with the last backup. The backup file is called “backup” and is located in the Radlink installation directory. The database is automatically synchronized upon the completion of the database restore process.

The “Purge Old Files” button purges images and log file entries older than the retention period. This action is automatically performed upon Radlink application startup. It is also automatically performed once per day in unattended router operation.
Chapter 4

ImageExpress™

for Remote Retrieval of DICOM Studies
Search DICOM Files

Downloading of files is asynchronous to the Radlink application. One can access this functionality by either clicking the “Radlink Image Express” icon on the desktop or by selecting “Search Server Files” from the file menu in the Radlink application.

Figure 4-1 – Activating Radlink Image Express

The following figure is the main screen for Radlink Image Express:
The bottom left of the screen is the status of the Image Express application. The five application states are:
- Idle. There are no images remaining to download.
- Waiting For New Images - Image Express is polling the server for new images.
- Radlink Connection In Progress. The Image Express application is logging into the Radlink server.
- Compression In Progress. Image Express is compressing the image for download.
- Download In Progress. The DICOM file transfer is currently in progress. The percentage of the file that has been downloaded is shown in the Transfer Status progress bar at the top of the screen.
- Decompression In Progress. The Radlink Image Express application is decompressing the image.

The files are downloaded to the Image Archive Directory and can be opened in the Image Acquire Open Archive screen.

The user name and password are assigned by your account administrator.
After one logs into the Radlink Server, the Radlink Search screen appears with the files uploaded that day. To view all files, unclick the “From:” check box. This will display all files uploaded to the Radlink folder before and including today.
Figure 4-8 – The Radlink Search Screen

The Search Screen file list can be sorted. Simply click on the column header above the column that is to be sorted on. This will be useful for rapidly finding a particular DICOM file. The default sort is on the Patient Name.

Search by Date

Searching for files by date is also supported. To search for files within a date range, simply click the drop down In the From box and pick the date you wish to search on:
The result of clicking the drop down on the From Date is shown above. To select a date, simply click the desired date. That date will then fill into the date field.

To enable the date search criteria, you must check the check boxes. To ignore the date selection, uncheck the check boxes. To select all files newer than a particular date, check the From box and enter the date and also uncheck the To Date check box. To find all files older than a particular date, uncheck the From Date check box and check the To Date check box. To find all files in a range of dates, check both boxes and fill in the appropriate dates as shown above.

Search by Name

If you wish to find all patients whose name starts with Thom, type Thom into the name field and push the Search button.

Search Results

Figure 38 shows the results of a sample search. In the example, all DICOM files for patient glenn over all dates will be returned. Please note that the search is case sensitive. Also note that the date check boxes were unchecked so dates weren’t included in the search criteria. Other search criteria can be selected as well. Patient ID, Accession number and Referring
Physician are also supported. If any of the criteria field boxes are left blank, they will be ignored in the search.

![Figure 4-10 – Results of Example Search for Patient seriestest](image)

If the file selected has no compression, a variety of compression choices are available at the lower left part of the screen. If one chooses a DICOM compressed format, the file will be compressed, transmitted to the workstation, then uncompressed at the workstation. If the file selected is already compressed, no compression or decompression will take place during or after the file transfer and the combo box for the download compression type is disabled.
File Transfer File Options

As shown in Figure 4-10, there are 3 compression types:

**DCM Uncompressed** – 16 will download the DICOM image from the *Radlink* server with no compression or image alteration.

**DCM JP2000 Lossless compression** – Lossless 16 bit wavelet compression yields between 3 and 5 to one compression ratios.

**DCM JP2000 Lossy compression** – Compression ratios from 5 to one to 40 to one are achieved with lossy 16-bit wavelet compression. A compression ratio of 30 to one with no perceptible loss of image quality is typical for most images.

![Figure 4-11 – File Transfer File Options](image-url)
Figure 4-13 – Selecting an Exam For Download

Figure 4-13 shows one file has been selected for download. One selects a file for download by clicking the gray box to the left of the desired file for download. One can select multiple files for download by holding down the “CTRL” key and selecting multiple rows. To select a range of files to download, first select the first file to download then hold down the “Shift” key and select the last file in the range of files to be downloaded.

Figure 4-14 – Multiple File Selection
In the above figure, all images for a particular exam have been selected for download. The setting for the compression technique to be used in the example above is “jpeg2000Lossy”. Other settings are shown in the following figure:

![Download Compression Settings](image)

**Figure 4-15 – Download Compression Settings**

After the files are selected and the proper compression settings are set, click the “Retrieve Files” button. The files will immediately start downloading.
The range of files to be transferred is then displayed with the top row being the file that is currently being transferred. The compressed file size and the compression technique being used are shown for the file currently being transferred. The percent complete for that file is also displayed in the progress bar. After the file is transferred, it is removed from the list and added to the Downloaded files list. When all files are transferred, the list becomes empty and you can then click “Browse Host Files” to retrieve more files. Note that this example described retrieving a series of images for a particular exam. One could retrieve any set of images desired for retrieval using the Radlink Search screen.

If Image Express is left running unattended, as images are uploaded to the Radlink Image Central, they will be automatically downloaded.

One can also view exams and download all images for the selected exams:
To download all the images for the selected exam, as shown above, click Retrieve Files. To view all images, click the radio button, “View All Files”. The following is the result of doing so in the above example:

Figure 4-18 – Viewing All Images

In the above figure, all images are listed. One can select specific images for download with the radio button “View All Files” selected. As shown, there are 4 images in the Exam for Patient Name “seriestest”. If one clicked the button
Retrieve Files button in Figure 1 above with the radio button set to View Exams and with “seriestest” selected, the following screen would appear:

![Download of the “seriestest” Exam](image)

When all images are retrieved, Image Express will begin polling for new images. It is important to note that the polling does not commence until the Browse Host Button is clicked. That action will allow one to log into the server and establish the connection. One does not have to select any files to be downloaded to begin the polling process, however.
Chapter 5: Image Central™ Web Service and the Browser Based Viewer

The Radlink Web Site and Account Management

User Account management is facilitated with the www.eRadlink.com web site. Log into the Radlink web site by clicking login on the left side of the Home Page:

![Image Central™ Web Service and the Browser Based Viewer](image)

Figure 5-1 – www.Radlink.com Home Page
The user name and password are the same as logging into the Radlink server from the Radlink application. The user name and password was generated by your Account Administrator.

Each user in the Radlink system has one of two levels of entitlement. The first is Account User. The second is Account Administrator.

The following describes the screens for the Account Users and Administrators.
After logging in, the system will take you to the above screen. There are 6 menu items on the left side of the screen. Home will take you to the Radlink Home Page. You are not logged out when going to the Home Page. To get back to the Radlink Main Page, simply choose login again from the Home Page and you will be taken there without the need for logging in again. To log out of the Radlink web site, click on” Log Out”. For security reasons, the password should be changed after the first time you log in and periodically thereafter.
You should make the password at least 6 characters long and include a numeric and also a special character such as an exclamation point. You need to enter the password twice. If they match, your password is updated after pressing the update button. You can view and update your profile information by pressing the User Profile Menu Item on the left side of the screen:
Please update the your profile information as needed. This is done by pressing the Edit Profile button. The email information is especially important. Major changes and release announcements will be communicated to you using your email address.

To view your account profile information, click on the Account Profile menu item on the left side of the screen.

![Figure 5-5 – Radlink User Profile Screen](image)
The Account Administrator is listed as the Account Owner. In the above example it is A. Demo. The phone number for support is also listed. The client ID is the client title that you need to specify in the user preferences screen of the Radlink Application as shown in figure 44 above.
To view contact information of all users in your account, push Users on the left side of the screen:

![Figure 5-7 – Radlink Users Screen](image-url)
The following section applies to Account Administrators only:

To view the users in your account push the Users menu item on the left side of the screen:

![Radlink Users Screen](image)

**Figure 5-8 – Radlink Users Screen**

Account Administrators will see three buttons enabling them to edit, create, and delete users. To create a user, push the create user button.
The user name is the user id the user will use to log into the web site and the Radlink Application. It must be entered and should not contain any spaces. The password must also be entered. You need to communicate the user name and password to your new user. It is also highly recommended that you enter the user’s email address. The other fields are optional, but it is recommended that they be filled out.

To edit a user’s profile information, the user must first be selected on the users screen:

Figure 5-9 – Radlink Create User Screen
To select a user for editing, push the > button to the left of the desired user. When a user is selected, the edit user and delete user buttons are enabled and the selected user is highlighted. To edit the user, push the edit button and edit the user as described in the edit user section earlier in this document. To delete a user, push the delete user button.
To edit the account profile information, click on the Account Profile button on the left side of the screen and push the Edit Profile button:
The Account Information should be completely filled out. The Account Owner and Client ID cannot be modified. You need to call Radlink to make changes to these fields. To persist the changes to Account Information, push the Update button.
To view server usage statistics, click “Accounting”. This displays the monthly totals of images sent to the eradlink server and images downloaded both by image express as well as by web pages:

![PACS Usage Statistics](image)

**Figure 5-13 – PACS Usage Statistics**

The totals are displayed by month and show totals for:

1. Studies sent to the Radlink Server.
2. Images sent to the Radlink Server.
3. Images viewed by the Radlink Web Server.
4. Images downloaded by Image Express.

The Radlink web site also has image viewing capabilities. One can view the Exams for his account by logging onto [www.Radlink.com](http://www.Radlink.com) and clicking “Exams” on the left side of the web browser.
One can view the Exam information by selecting the desired exam and clicking "View Exam". These exams can be sorted by Name, UID, Date, PatientID, or Modality as shown in the above figure. To select an exam, push the "->" button on the left of the row containing the desired exam.
In the above figure, the exam for patient “seriestest” has been uploaded to the Radlink server. User A. Demo has logged in and has selected that exam for viewing. He then selects image 2 by clicking the > button. The following screen then appears:
One sets the window level by selecting Image→Adjust→Window/Level menu item in Image J:
After selecting window level, the following applet window appears:

One then moves the sliders for window/level to obtain the desired window/level setting:
Figure 5-19 – Image After Setting Window/Level
Appendix
## Appendix

### Table 6 – Hardware Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Film size</strong></td>
<td>Min: 2 inch x 2 inch&lt;br&gt;Max: 14 inch x 15 feet</td>
</tr>
<tr>
<td><strong>Scan time</strong></td>
<td>.5K mode – 6 seconds&lt;br&gt;(14” x 17” film)&lt;br&gt;1K mode – 12 seconds&lt;br&gt;2K mode – 25 seconds&lt;br&gt;3K mode – 37 seconds</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB or Ethernet</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>18”(w) x 12”(d) x 12”(h)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>26 lbs.</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Input voltage 85 to 264 VAC&lt;br&gt;Input frequency 47 to 440 Hz&lt;br&gt;Input current 3.2A for 115 VAC 60 Hz&lt;br&gt;0.9A for 230 VAC 50 Hz&lt;br&gt;Internal voltage/current +5 V at 10A max&lt;br&gt;+12 V at 1A max&lt;br&gt;-12 V at 1A max&lt;br&gt;+24 V at 5A max</td>
</tr>
<tr>
<td><strong>Laser</strong></td>
<td>Type Solid State&lt;br&gt;Power 35 mw</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Spatial 3072 pixels over a 14 inch scan line</td>
</tr>
<tr>
<td><strong>Grayscale</strong></td>
<td>16 bits</td>
</tr>
<tr>
<td><strong>Optical Density range</strong></td>
<td>0.00 to 4.00 Transition of density&lt;br&gt;5 pixels or less</td>
</tr>
<tr>
<td><strong>Signal-to–noise ratio</strong></td>
<td>4 to 1 at 0 to 4.0 Optical Density&lt;br&gt;0.001 O.D. at density 1.5 O.D.&lt;br&gt;0.01 O.D. at density 2.5 O.D.&lt;br&gt;0.1 O.D. at density 3.5 o.d.</td>
</tr>
<tr>
<td><strong>Geometry</strong></td>
<td>? one pixel of true position over entire film</td>
</tr>
<tr>
<td><strong>Pixel output Modes</strong></td>
<td>3K scan line 3072 pixels over 14 inches</td>
</tr>
<tr>
<td><strong>Output format</strong></td>
<td>(All scan modes) 8,12 or 16 bit (65,536 grayscale)</td>
</tr>
<tr>
<td><strong>Gamma tables</strong></td>
<td>16, 12 or 8 bits&lt;br&gt;Programmable LUT&lt;br&gt;Default: linear (to O.D.) 2 programmable</td>
</tr>
</tbody>
</table>
## Table 7 – Error Conditions and Actions

<table>
<thead>
<tr>
<th>Error Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No power to the scanner</td>
<td>Check that the Power Switch on the scanner is “ON”. The Power Supply has a number of protection circuits which sense “over voltage”, “over current” and “input surge protection”. Any of these conditions will cause the Power Supply to trip a fuse. Call Radlink for further action.</td>
</tr>
<tr>
<td>Film Jam</td>
<td>Unlatch back panel. Remove film, close panel and replace film. Scan will continue. If the problem persists, check the film for labels or tape which can cause uneven feed problems. *</td>
</tr>
<tr>
<td>Vertical black lines</td>
<td>Check the film for lines. If O.K., unlatch the back panel and wipe a soft cloth dipped in alcohol across the Sensor PCB to remove dirt. Close panel and scan again.</td>
</tr>
<tr>
<td>Film feeding unevenly (skewed)</td>
<td>Turn scanner power off. Unlatch the Back Panel. Remove film and check for labels or tape. Check the Feed Rollers for dirt. Turn Power On, close Back Panel and replace film. Scan will continue.*</td>
</tr>
</tbody>
</table>

- If a problem persists, call Radlink Customer Service for guidance.
HIPAA and the Advanced Encryption Standard

The Radlink system addresses HIPAA security requirements:

The preceding diagram illustrates the security components of the Radlink system. The following items describe each component illustrated above.

1. Radlink Web Browser – The web interface to the Radlink Web Server is now utilizes the Secure Socket Layer (SSL) and enforces 3DES encryption. All transmissions to the web site, including images, are encrypted.
2. Radlink Image Express – Image express now utilizes the Advanced Encryption Standard, Rijndael Symmetric encryption for all communications to the Radlink DICOM server. Once DICOM images are downloaded, they are automatically unencrypted and can be imported into third party DICOM viewers or opened with the Radlink application. No firewall is shown in the figure for Image Express. If one is needed, an inexpensive Network Address Translator (NAT) could be utilized. Firewall functionality comes standard with Windows XP Home and Professional.

3. For compatibility with other systems, unencrypted DICOM communications will continue to be supported. DICOM communications from applications such as eFilm are supported. In addition, DICOM communications to PACS servers from the Radlink DICOM spooler is supported as before.

4. The Radlink DICOM spooler will now encrypt all communications to the Radlink DICOM Server using the Advanced Security Standard Rijndael Symmetric encryption algorithm. For installations that wish to transmit images from other Modalities, a Modality Router is added to the Radlink system. This feature will accept all images from various modalities and forward them encrypted to the Radlink DICOM Server utilizing the DICOM Spooler. Images could also be forwarded to unencrypted servers such as a local PACS server using the Modality Router and the Radlink DICOM spooler.

5. The Radlink servers are secured using the HIPAA security guidelines as written by Microsoft. These guidelines are in the following sections with the details of the Rijndael encryption algorithm.